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Background

▪ JMP Scripting Language (JSL) は非常に便利なツールである。

–解析結果をテーブルスクリプトとしてデータテーブルに保存して記録として残す、また
は他の人に共有する、という使い方はほぼすべてのJMP Userが経験があるはず。

▪ JSL作成を支援する機能は、Version upgrade毎に進歩している。

–JMP 16 – Action Recorder (Enhanced Log) の導入

–JMP 17 – Workflow Builder の導入

▪上記の機能を使うことで解析ダッシュボードなどを作成するJSLを活用しているJMP User
も多いはず。本発表では、作成したJSL (Workflowなども含む) をより活用するためのヒ
ントを共有します。

–JSLによるデータ自動更新の際の問題点とその対処法

–JMPファイルを多人数で共有する際の問題点とその対処法

–複数のExcelファイルを連結してデータセットを作成する (JMP 17の時点では、Import 
Multiple Files では Excel Import Wizardのような細かい読み込み設定ができない)

–メールを送信する (会社のセキュリティの制約でMail関数が機能しないケース)
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▪ Scenario: JSLでDataset更新とDashboard作成ができるようになった。

–Process Screening: CapabilityとStabilityの確認

–Analyze > Quality and Process > Process 
Screening

–CapabilityはSpecに対する工程能力で評価する

–StabilityはStability Index (SI)で評価する

–平均値のシフト、ドリフト → SI大

Dashboard Example
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<Process Screening> <Control Chart – 1st page> <Control Chart – 2nd page>
“Thickness” “Strength”

–Control Chart: トレンド、Stabilityの確認

–Analyze > Quality and Process > Control Chart 
Builder

–Average chart: サブグループの平均値

–Moving Range chart: サブグループ間の短期変動

–Standard Deviation chart: サブグループ内バラツキ
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DashboardExample.jmpaddin

–Update Dashboard: master file、Dashboardを最新のデータに更新する。

–HTML Dashboard: HTML版のDashboardをブラウザで開く

–Generate New Data: 新しいExcelデータをSample Dataフォルダに生成する

–Open master file: master file (Sample Dataフォルダ内のExcelを積み上げたファイル) を開く

–Open Sample Data Dir: Sample Data フォルダを開く
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<Update Dashboard><Menu>

<Open Sample Data Dir>

<Lot_1.xlsx>
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JSLによるデータ更新の自動化

▪ Scenario: JSLでDataset更新とDashboard作成ができるようになった。

–チームメンバーと共有することになった。メンバーの為にも毎朝更新しなければならない。

▪ Ideal: 定期的に自動でDatasetとDashboardを更新しておく

–Tool: Windows Task Scheduler & JSL

–Potential problems: 

–共有サーバのファイルを開くときに警告メッセージ

–誰かがDatasetを開いている間は更新作業ができない。更新時以外はDatasetを読み取り
専用で開いて欲しい。

–更新担当者が不在の時は更新されない → サブの更新担当者 or 終日稼働PCに設定
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定期的に自動でデータセットとDashboardを更新しておく

▪ Windows Task Scheduler

–決められた時間または一定間隔でプログラムやスクリプトを実行するツール

–Program Menu > Windows Administrative Tools (Windows管理ツール) > 
Task Scheduler (タスクスケジューラ) で起動する。

–右側のActionsのパネルから新しいTaskを作成する。
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<Windows Task Scheduler>
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Windows Task Schedulerの設定

▪ Trigger (スクリプトの実行タイミング: 毎週月～金の8:30に実行)

–On a schedule > Weekly > 日付時間入力 > Monday～Fridayにチェック

▪ Action (この設定の場合、平日の朝8:30に新しくJMPを起動しスクリプトを実行する。スクリプト
の最後に quit(nosave) を入れておくとJMPを終了できる)

–Program/scriptにjmp.exeの場所を””(ダブルクォート)で囲って入力。JMPのVersionを更新した
ときは修正が必要！

–"C:¥Program Files¥SAS¥JMPPRO¥17¥Jmp.exe"

–Add argumentsに実行するJMP Scriptのpathを入力 (“”は不要、path中の () はエラーの原因)

–例 C:¥Users¥Public¥Documents¥DBExample_autoupdate.jsl
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<Trigger> <Action>
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問題点 - 共有サーバのファイルを開くときに警告メッセージ

▪共有サーバにあるJMPファイルを開くときに警告ダイアログが出てスクリプトが止まって
しまう。

–人の操作はできる限り避けたい！

▪対処法: Windows > Internet Options の設定
– https://community.jmp.com/t5/Discussions/How-to-disable-JMP-security-warning/m-p/56334#M31632
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対処法 - 共有サーバのファイルを開くときに警告メッセージ (1)

1. Windowsの設定画面を開く (Startボタン > ⚙(設定)ボタン)

2.検索窓に “internet options” (日本語だと “インターネットオプション”) と入力 → 表示される
候補を選択

3. Security > Local Intranet > Sites > Advanced 
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対処法 - 共有サーバのファイルを開くときに警告メッセージ (2)

4. file:// に続けて共有サーバの場所を入力して Add で追加する
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問題点 – Datasetを更新時以外は読み取り専用で開きたい

▪ 1つのJMPファイルを複数人で共有すると以下のようなことが発生するリスクがある。

–誰かが開いている間はファイルがロックされた状態となり、更新時の上書き保存不可能。

–勝手に編集されてしまいスクリプトがエラーになる。

▪対処法：閲覧用に読み取り専用扱いで開けるファイルを別途作成する。

–JMP 17時点ではExcelのような読み取り専用設定はない。データテーブルのロックは可能。
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対処法 – Datasetを更新時以外は読み取り専用で開きたい

▪データセット (dt) のコピーをJSLとして保存する

–dt << get script でdtをスクリプトとして取得

–Save Text File (Path, textblob)で jsl の拡張子で保存。

–1行目にスクリプトを自動実行する //! (+ 改行) を記述する。

–作成したJSLファイルを開くとデータセットのコピーが開く。

–このJSLファイルを書き換えることは困難 → 実質読み取り専用として機能する。

–保存を試みると名前を付けて保存のメニューが開く。同じ名前で上書き保存は可能なの
で、get script の前に名前を変える or コピーは別の場所に作成するのが理想。

14

▪ Example
//open “big class”
dt = Open( "$SAMPLE_DATA/Big Class.jmp" );
myname = dt << getname(); //get name
//save dataset as jsl
myscript = dt << get script;
Save Text File("$DOCUMENTS/"|| myname ||".jsl",
"//!
dt = " || Char( Eval Expr( myscript )));

<保存されたjslの中身>

<jslの実行結果>
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複数のExcelファイルを連結してデータセットを作成する

▪フォルダ内のExcel fileを連結したデータセット作成。

–ロットごとに評価結果のファイルが作成される状況を想定。

▪基本的な流れ

–開きたいファイルのリスト (myfiles) を作成して、for loopで順に開
いて、concatenateで連結する。

–Import Multiple Files では Excelの細かい読み込み設定ができない。
– https://community.jmp.com/t5/JMP-Scripts/Combine-multiple-excel-files/ta-p/312101
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▪ Example
myfiles = Files In Directory( mydir ); //file list
//loop to open and concat files
For( i = 1, i <= N Items( myfiles ), i++,

dt0 = Open( mydir || myfiles[i] ); //Excelの読込設定は省略

dt << concatenate( dt0, append to first table );
dt0 << close window( nosave );

);

<フォルダ内のファイル>

<フォルダ内のファイルをリスト化>

https://community.jmp.com/t5/JMP-Scripts/Combine-multiple-excel-files/ta-p/312101
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複数のExcelファイルを連結してデータセットを作成する

▪フォルダ内のExcel fileを連結したデータセット作成。

–ロットごとに評価結果のファイルが作成される状況を想定。

▪問題点/要求事項

–対象外のファイルがある。例えば、html や word などの拡張子違い。
→ 拡張子でファイルをフィルタ

–新規ファイル (現在のデータセットにないファイル) だけを読み込みたい。
→ データセットにあるファイルのリストと対比して新規ファイルを特定

–ファイルは複数の評価項目について何度かに分けて入力される。新規ファイルの読み込
みと更新があったファイルのデータの差し替えを行いたい。
→ データセットにあるファイルの更新日時と対比して新規/更新ファイルを特定
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対処法 - 対象外のファイルがある (拡張子でファイルをフィルタ)

▪ 対象データはある品番フォルダ内のロットごとのエクセルファイル。

–Files in Directory (folder path) でフォルダ内のファイルリスト作成 (対象外のファイルを含む
可能性がある)

–myfiles0 = {“Lot_1.xlsx”, “Lot_10.xlsx”, “Lot_2.xlsx”, "Lot_3.xlsx", "Lot_4.xlsx", 
"Lot_5.xlsx", "Lot_6.xlsx", "Lot_7.xlsx", "Lot_8.xlsx", "Lot_9.xlsx“, “SPC_MST.jmp”}

–Contains(対象文字列, 検索文字列) は、対象文字列中の検索文字列の位置を返す。なければ0。

–例えば contains (myfiles0[1], “xlsx”) → contains (“Lot_1.xlsx”, “xlsx”) → 7 
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▪ Example
myfiles0 = Files In Directory( mydir ); //file list
//blank list for xlsx files
myfiles = {};
//search xlsx file and insert into the list
For( i = 1, i <= N Items( myfiles0 ),i++,

If( Contains( myfiles0[i], ".xlsx" ) > 0,
Insert Into( myfiles, myfiles0[i] ))

);
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対処法 - 新規ファイル (現在のデータセットにないファイル) だけを
読み込みたい。

▪ JMPのデータセットには Source File の列を準備しておく

–dt << newcolumn("Source File",character,seteachvalue(myfiles[i]));

▪ Source File列にある一意なデータのリストを作成しておく

–sourcelist = Associative Array( dt:Source File ) << getkeys;

–Contains(対象リスト, 検索要素) は、対象リスト中の検索要素の位置を
返す。なければ0。
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▪ Example
myfiles0 = Files In Directory( mydir ); //file list 
//get current source file list
sourcelist = Associative Array(dt:Source File) << getkeys; 
myfiles = {};//blank list for xlsx files
//search new file and insert into the list
For( i = 1, i <= N Items( myfiles0 ),i++,

If( Contains( sourcelist, myfiles0[i]) == 0,
Insert Into( myfiles, myfiles0[i] )));

<DashBoardExample.jmp (dt)>

<sourcelist>
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対処法 - 新規ファイル (現在のデータセットにないファイル) を読み
込み、更新があったファイルの部分を更新したい。

▪ データセットにはファイルの編集日時の列(ModifyDate)を準備

–Last Modification Date (path) は、ファイルの編集日時を返す。

–dt << newcolumn(“ModifyDate”,numeric,seteachvalue(mymod)); 

▪ 対象ファイルの編集日時とデータセットに保存されている編集日時が一
致しない場合はデータセットから対象ファイルの行を削除する

19

▪ Example
For( i = 1, i <= N Items( myfiles ), i++,

mymod = Last Modification Date( mydir || myfiles[i] );
mysel = dt << selectwhere( :Source File == myfiles[i] ) << getselectedrows;
If( N Items( mysel ) > 0 & Column( dt, "ModifyDate" )[mysel[1]] != mymod,

dt << deleterows
););

<DashBoardExample.jmp (dt)>
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その他の課題、要望

▪メニューから簡単にJSLを実行したい、ダッシュボードを開きたい。

–アドインを作成する

▪非JMP Userにもダッシュボードを共有したい。

–PDF

–myreport << Save pdf ( mydir || “Dashboard.pdf" );

–Interactive HTML

–myreport << Save Interactive HTML( mydir || “Dashboard.html", "html" );

▪スクリプト実行時にチェックを行い、特定の状況の場合に関係者にメール通知したい。

–JSLのMail関数は会社のPCの制約などでメール作成までしか実行しない状況を想定

–MS Power Automateと連携して送信

–メールを送信するVBScriptファイルを動的に作成してそれを実行して送信
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メニューから簡単にJSLを実行したい、ダッシュボードを開きたい

▪アドインを作成する

–新規作成: File > New > Add-in

–編集: Open > ファイルを選択 > ▼ Open using Add-in Builder
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<Add-inに登録されたMenu><Add-inの新規作成>
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メニューから簡単にJSLを実行したい、ダッシュボードを開きたい

▪アドインの設定

–General Info: Add-in Name → 何でも良い, Add-in ID → ユニークに。

–Menu Items: Add Commandでメニューを追加、Actionに実行内容をJSLで記述

–Additional Files: Add-inで使用するファイルを追加

–“$ADDIN_HOME(Add-in ID)” が保存フォルダのパス変数。

▪アドインのインストール

–保存したjmpaddinファイルを実行するとAdd-insのメニューに追加される。

–削除したい場合は、View > Add-ins... > 選択して Unregister 
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<General Info> <Menu Items> <Additional Files>
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非JMP Userにもダッシュボードを共有したい

▪ PDF

–myreport << Save pdf ( mydir || "Dashboard.pdf" );

–例えば MS Teams (SharePoint) のChannel内にPDFをタブとし
て追加→ SharePointと同期したOneDriveフォルダにpdfを上書
き保存することで、PDFのタブが更新される

▪ Interactive HTML

–myreport << Save Interactive HTML( mydir || 
"Dashboard.html", "html" );

–ブラウザで開けるHTMLの形式で保存して共有。
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<MS Teamsのタブに追加
したDashboardのPDF>

<ブラウザで開いたHTML形式のDashboard>
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スクリプト実行結果に基づいてメール送信

▪ JSLのMail関数は会社のPCの制約などでメール作成までしか実行しない状況を想定

▪ MS Power Automateと連携して送信

1. JSLがOneDrive (またはSharePointと同期したOneDrive) のフォルダにExcel形式で
ファイルを保存

2. OneDrive/SharePointフォルダでのファイル作成/更新をトリガーにPower Automate
フロー実行

3. メール送信 (Send an emailのステップ、例えばExcelファイルを添付しておく)

–Office ScriptでExcelにテーブルフォーマットを設定すれば中身を読み取ってメール本文
に記述するなども可能。

▪ メールを送信するVBScriptファイルを動的に作成、それを実行して送信

–2023/10 Microsoft社は将来のWindowsリリースでVBScriptを削除することを発表。し
かし当面の間は使用可能。
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メールを送信するVBScriptファイルを動的に作成→実行して送信
(MS Outlookの例)

▪ Save Text File (Path, textblob)でメールを送信するVBScriptファイルを動的に作成

–mail_test.vbs が作成される。作成→実行の間に念のために1秒の待機時間を設けている。

–Preferences(Open Text File Charset()); は文字化け抑制のため。
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▪ Example
maillist = "mailto1@abcd.efg;mailto2@abcd.efg";
myitem = "Test Product1"; mylot = "1234567"; myresp = "Thickness";
Preferences(Open Text File Charset( "utf-16" ));
Save Text File( "C:¥Users¥Public¥Documents¥mail_test.vbs",  
"Option Explicit
Dim olk, item, rc
Set olk = CreateObject(¥!"Outlook.Application¥!")
Set item = olk.CreateItem(0)
rc = vbCrLf
item.To = ¥!"" || maillist || "¥!"
item.Subject = ¥!"Test: Out-of-Control Alert¥!"
item.Body = ¥!"Item#: " || myitem || "¥!" & rc & ¥!"Lot#: " || mylot || "¥!"
& rc & ¥!"Response: " || myresp || "¥!" & rc & ¥!"Out-of-Control occurred.¥!"
item.Send
Set item = Nothing
Set olk = Nothing
WScript.Quit 0" );
Preferences(Open Text File Charset( "Best Guess" ));
Wait( 1 );
Open( "C:¥Users¥Public¥Documents¥mail_test.vbs" );

メールで使用
する変数

メール送信す
るvbsの本文

メール送信す
るvbsの実行
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スクリプト実行結果に基づいてメール送信

▪ 以下のようなvbsファイルが作成される。

–Open( “C:¥Users¥Public¥Documents¥mail_test.vbs” ) で実行するとメールが送信される。
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<受信したメール><作成したvbsファイル>
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Summary

▪ JMP/JSLでアプリケーション作成を行う上での以下のようなTipsを共有しました。

–定期的に自動でデータセットとDashboardを更新しておく → Windows Task Scheduler

–共有サーバのファイルを開くときに警告メッセージを抑制する → Windowsの設定

–更新時以外はデータセットを読み取り専用で開きたい → データセットのコピーを自動実行の
JSLで作成

–複数のExcelファイルを連結したデータセットを作成する → 開きたいファイルのリストを作っ
てFor Loopで読み込む

–メニューから簡単にJSLを実行したい、ダッシュボードを開きたい → アドインの作成

–非JMP Userにもダッシュボードを共有したい → PDF、Interactive HTML

–スクリプト実行結果に基づいてメール送信 → MS Power Automateと連携、VBScriptで送信

▪ これらが皆様のJMP活用の一助になれば幸いです。

▪ JMP Community (https://community.jmp.com/) にヒントや答えをもらったものも含まれて
います。先人たちの知恵に心から感謝致します。
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https://community.jmp.com/
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